1.Installation and Upgrading

All the COGO+50 files mentioned below are available for download at http://surv50.ca/downloads.html.
The instructions for Method 1 are for PC users and require a SD card. The instructions for Method 2 re-

quire the HP 50g, 49g+ and 48glIl PC Connectivity Kit which can be downloaded from http://www.hpcalc.
org/details.php?id=5890. Method 1 is the recommended method.

1.1.Install using SD Card

STEP 1: Download the file COGOPLUS.zip by selecting the
“"COGO+50 Complete” option, see Figure 1.1, and save to a desti-

nation of your choice.

STEP 2: Navigate to the folder where you saved the file, right-click on

extract the contents of the file, see Figure 1.2.
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» Download Program Files

Some files are provided in the compressed ZIP format. Software such

as the open source 7-Zip can be used to extract these files.
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STEP 3: With the SD card in the card reader, enter the drive letter for your SD card, for example I:\,

and click “Extract”, see Figure 1.3.

STEP 4: Insert SD card into calculator.

STEP 5: Press (<1 ), then to access the File Manager, see Figure 1.4.
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STEP 6: Press to browse the SD card.
STEP 7: Locate the COGOPLUS directory and highlight it, see Figure 1.5.
STEP 8: Press (» to browse the COGOPLUS directory, see Figure 1.6.

STEP 9: Highlight INSTALL.HP and press to begin the installation process. First you will be asked
whether or not you wish to backup your calculator., see Figure 1.7. Included with the Version 2.1 pro-
gram files is a very nice backup management system that you can use at any time to backup your data
or restore a backup. Enter a name to call this backup, for example MAY02 as shown in Figure 1.8. The
backup tlme will vary dependlng on how much memory is used up in HOME directory, then a message
displaying Im=tallirma. « « will remain on the screen while the program is being installed. Another
new optlon in Ver5|on 2.1 is presented after COGO+50 is installed, you are asked whether you wish to
install SDfiler or not, see Figure 1.9, unless SDfiler is already installed, in which case the option is not
presented. This is optional but recommended if you will be doing a lot of exportlng of ASCII files, see
Section 2.4 of the manual for more information about SDfiler. Again the Ir= i . message is
on the screen while SDfiler is installed. Once installation completes you WI|| see the message to warm-
start the calculator, see Figure 1.10.
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NOTE: The COGOPLUS directory needs to be in the root directory of your SD card to work properly.

Within the COGOPLUS directory are the following:

« ASCII subdirectory - Contains a few *.TXT files by default that are used in some of the examples in
the manual, and this is where exported ASCII files are saved to on the SD card, and by default the
Import Points program will open this directory to look for files to import.

« BAK_DIR subdirectory - Contains a clean DEFAULT.BAK backup and a sample flag settings backup.
All backups and the flag settings backup are stored in this directory, and the RESTORE.HP program
looks in this directory for backups to restore.

*  PROGRAM subdirectory - Contains C50P.LIB, the COGO+50 library file, and the SDfiler files, called
L935.HP and L936.HP.

»  BACKUP.HP - A backup tool that stores backups in the BAK_DIR, asks for a name to save the
backup as.

e INSTALL.HP - The installation program for COGO+50.

+ RESTORE.HP - A program to restore saved backups.
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1.2.Install using HP 50g, 49g+ and 48gII PC Connectivity Kit

STEP 1: Download the file C50P.LIB by selecting the "COGO+50 Library file only” option and save to a

destination of your choice.

STEP 2: Navigate to the folder where you saved the file, right-click on it and select “Copy” to copy the
file C50P.LIB to the Windows clipboard.

STEP 3: Connect USB cable between PC and calculator.

STEP 4: Open Connectivity Kit (Conn4x) on your PC.

STEP 5: On the calculator (RPN mode) type the command

and press (evEr), see Figure 1.11.

STEP 6: In Connectivity Kit from the File Menu select “Connect...”,
see Figure 1.12, and press OK in the following dialog box.

STEP 7: From the Edit Menu select “Paste”, see Figure 1.13.
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STEP 8: From the File Menu select “Disconnect from the calculator”.

Figure 1.13

STEP 9: On the calculator, make sure you are in the HOME directory, if not return to HOME directory

and press ().

Library to the stack. With normal stack display mode yt;u WI|| see L.ibw~

on level 1 of the stack, as shown
in Figure 1.15.
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STEP 11: Press (2 ), then (5], or enter ¢ =Til as shown in Fig-  |[pEG %yz DEC €~ 'H°
ure 1.16 and press (@) . {E.H'IJHE}
5:
STEP 12: Warmstart the calculator by holding down and then 4:
pressing (5 . %
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NOTE: Some users experience difficulty connecting the calculator with the HP 50g, 49g+ and 48glII PC
Connectivity Kit, if at all possible try using a SD card for the installation if you're attempting Method 2
and it is not working for you.

If you experience difficulties trying to install the program, do not hesitate to contact me.

1.3.Upgrade using SD Card

It is recommended to install Version 2.1 as if it was a new install, overwriting the existing directory
COGOPLUS directory on your SD card. The new installation and backup programs require the new sub-
directories.

For future upgrades, download the latest C50P.LIB file and copy it into the PROGRAM sub-directory within
the COGOPLUS directory on your SD card, then install as described in Section 1.1.

1.4.Upgrade using HP 50g, 49g+ and 48gII PC Connectivity Kit

PURGE the existing copy of COGO+50 by entering :2:930 PURGE, DEG HYZ DEC Lo 'H* FRG
see Figure 1.18, then install the latest C50P.LIB file as described in .t
Section 1.2. =
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2.Getting Started

After the software is installed, there are 3 ways to access the COGO+50 library:

1. Type (in RPN mode) -3+ and press (ever), or

2. Press then to access the library menu and look for the menu label i. Pressing the cor-
nding key will bring up the menu for COGO+50 which contains just the one menu item labelled
. Press (7 ) to start the program, or

3. Press (aprs) then cay. COGO+50 will be an entry near or at the bottom of the list, highlight it and

press (f ).

Another option is to add COGO+ to your CST variable to access the library from your custom menu, see
the Addendum for more information.

2.1.Serial Number and Key

A activation key is required to unlock all the features of COGO+50.
A limited DEMO mode is available until a valid key is entered. Visit B+ ':':'G_':""SE'
http://surv50.ca/sales.html to purchase a activation key. The key will persion 2.1

: : L BBEEETE
be emailed to you after the purchase order is completed. Serdal: EWNEl FuF
Enter Rew to ACTIVATE..

Figure 2.1 is an example of the screen you'll see the first time run-
ning the program. The serial number shown on the screen is the
internal serial number that is matched to the activation key. The key

is stored on the calculator as ‘SurveKey’ in Port 2 when a valid key is Figure 2.1
entered. You will not be required to enter the key again unless the
key is somehow deleted. AR Default
0 Foints | DAE | AE | TN,E | +D0

T_he Main Menu as shown in Figure 2.2, is the screen the program B Hd?LIS‘t- S
displays when started. C1 Surveging
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Figure 2.2

2.2.Configuring Settings

COGO+50 offers flexibility and ease of use regardless of what the user is accustomed to by providing
various user settings. Some of these settings are visible on each menu screen as a status row indicating

current settings: 0 Foantz | DA | AZ | ML,E | +0

1 2 3 4 5

Number of points stored in the current job

Angle unit set (DegreesMinutesSeconds/DecimalDEGrees/ GRaDs)

Direction preference set (AZimuths/QuadrantBearings/SouthAzimuths)

Coordinate display preference set (Northing,Easting/Easting,Northing/x-Coordinate,Y-Coordinate)
Description prompts enabled or disabled (4 Descriptions/=Descriptions)
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http://surv50.ca/cogo.html

The settings program is found
in the Tools Menu, see Figure
2.3. From the Main Menu press
followed by to open
the User Settings input form, see
Figure 2.4. Select your preferred
settings and press to save
them. These settings remain
unchanged until changed by the
user.

2.3.Shortcut Keys
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As you can see in Figure 2.3, there is a column of letters in inverse video displayed at the very right hand
side of the screen. These letters indicate the shortcut keys that can be used to access the corresponding
program within the library. For example, instead of pressing then from the Main Menu to ac-
cess the User Settings input form, you could also just have pressed the “Y” key, ( ). These shortcuts
are available from any menu for any of the programs but are not available from within programs.

Pressing :

+ Cancels the current program if a program is active,
* Returns to the Main Menu if a sub menu is active, or
+ Exits the library if the Main Menu is active.

Below is a table listing all of the shortcuts, based on the alpha labels on the corresponding keys:

G = Triangle Solver T = Traverse

H = Horizontal Curve Solver U Plot Points

I = Inverse \ Vertical Curve Solver
J = Job Manager W Linear Regression

K = Area by Points X Import/Export

L = Levelling Y Settings

M = Pre-determined Area*** Z Inaccessible Point

N = Store New Point 1 Compass Rule

O = Offset Intersection 2 Rotate Points

P = Point-to-Point 3 Shift Points

Q = Delete Points 4 Scale Points

R = Recall Points 5 2D Helmerts

S = Alignments 6 Azimuth/Bearing Conversions

***Indicates the program will be included in a future update
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2.4.0ther Information

Some general information regarding COGO+50:

1.

Quadrant Bearings are entered with the quadrant preceding the
bearing to form a number in the format QDD.MMSS. For example,

to enter the bearing of N16°30'15”E you would enter the bearing 4 /H
as 11&. 2815, Quadrants are defined as shown in Figure 2.5.
With quadrant bearings set as the directions option, the bearing

must begin with the quadrant (1 to 4) as the first character other- 3 2
wise resulting in an error if the first character is not in the range
of 1to4. (NOTE: You may also set quadrant bearings as direction
setting in combination with angle unit setting as decimal degrees, Figure 2.5

QDD.dddd, or grads, QGG.gggg.)

COGO+50 saves all data in the Hidden Directory to avoid unintentionally altering and/or corrupting
files that could cause instability of the program. Backups and restores include everything in the hid-
den directory.

Flag settings and display mode are changed by COGO+50 upon program startup, but then restored
after exiting the program.

Choose fields such as the ones found within the User Settings input form may be toggled by pressing
the <O or O arrow keys.

In almost all cases pressing the key is equivalent to pressing the
key is equivalent to the [ softkey ( ).

Since Version 2.1, COGO+50 sets System Flag 60 upon program startup which requires just a single
keypress to lock alpha mode.

New in Version 2.1, if you have SDfiler installed on your calculator (http://www.hpcalc.org/details.
php?id=6524), then any ASCII files that are exported to the SD card will not contain the HP header
information that you need to delete before importing into a CAD program for example. This saves a
step, but it is not a requirement. SDfiler is a C library written by Tim Wessman and Claudio Lapilli.

ii softkey ( ), and the
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